Installation and Set Up Overview

Table of Contents

About Armstrong/SteamLogic™ ................................................. 3
Installation .............................................................................. 4-12
Downloading SteamLogic™ ..................................................... 13
Verifying Computer Properties .............................................. 14
Installing Microsoft .NET Framework ..................................... 15
Uninstalling SteamLogic™ ..................................................... 16-19
Initial Startup ......................................................................... 20
SteamLogic™ Homepage ......................................................... 21
Setup ....................................................................................... 21
Adding A New Gateway .......................................................... 22-23
Configuring Devices ............................................................... 24-26
Troubleshooting Tips .............................................................. 27
Reporting Groups .................................................................... 28
Preferences ............................................................................ 29
Monitoring .............................................................................. 30-32
Backing Up/Restoring The Database ....................................... 33
Best Practices ........................................................................ 34
Appendix A - Advanced Setting - Noise Filter Level ............... 35-38
Appendix B - Advanced Setting - Temp. Deadbanding ............ 39-42
Appendix C - Advanced Setting - Device Status Alert ............ 43-46
Appendix D - Starting/Stopping the Polling Service .......... 47-48
Contact .................................................................................. 49
About Armstrong

Armstrong International provides intelligent system solutions that improve utility performance, lower energy consumption, and reduce environmental emissions, while providing an enjoyable experience. Founded in 1900, Armstrong International is a family-owned company headquartered in the United States, with manufacturing, sales and seminar centers located throughout North America, Europe, Asia, and the subcontinent of India. More information can be found at armstronginternational.com.

Knowledge Not Shared is Energy Wasted®

Knowledge Not Shared is Energy Wasted® is a philosophy of Armstrong, and the company is dedicated to the premise of sharing knowledge on a continuing basis.

Since Armstrong designed and manufactured its first steam trap in 1911, we’ve solved virtually every imaginable problem in steam trapping and steam humidification. In the process we’ve accumulated a substantial body of information. It’s practical know-how, not just theory. And for years we’ve shared this knowledge with anyone interested. We go to great lengths to share what we know because we’re convinced that this kind of interaction is the best way to solve problems, meet individual needs and maximize the return on your energy investment.

About SteamLogic™

Instant notification of failed traps is important because wasting money, time and losing carbon emissions can ultimately be prevented. Leaking or “blow thru” traps equal visible costs because of indicators such as loss of live steam and wasted CO2 emissions. Traps accumulating condensate generate hidden costs such as stalled or reduced production, damaged steam system equipment and pipes, increased maintenance costs and increased safety risks.

SteamLogic™ is a powerful software that brings Armstrong International's one-hundred years of experience to steam trap monitoring.

How It Works

SteamLogic™ receives acoustic and temperature signals from wireless field monitoring devices. After receiving the raw data, SteamLogic™ interprets the data and runs through a sophisticated algorithm designed by Armstrong to determine the current steam trap condition. Information required for the algorithm to function properly include steam application, steam trap type, inlet pressure and outlet pressure. The software then displays the current condition of a steam trap utilizing industry standard icons.
Installation

Requirements

The following software prerequisites must be met to run SteamLogic™:
1. Windows XP (32 and 64 bit), Windows Vista (32 and 64 bit) or Windows 7 (any)
2. Microsoft Internet Explorer 6.0 SP1 or above
3. Adobe Acrobat 7.0.7 or higher.
4. Microsoft .NET Framework 3.5 SP1

NOTE: To verify computer operating system, see page 14.

The following hardware requirements must also be met:
1. Processor: 2.6 GHz Pentium processor or equivalent (Minimum); 3 GHz Pentium processor or equivalent (Recommended)
2. RAM: 4 GB (Minimum); More (Recommended)
3. Hard Disk: 5 GB space (Minimum); 20 GB of available space or more (Recommended)
4. CD or DVD Drive: Required for CD-ROM install of SteamLogic™
5. Display: 1024 x 768 high color, 32-bit (Minimum)
6. LAN TCP/IP network connection to the HartIP network

NOTE: To see if Microsoft .NET Framework 3.5 is installed go to
C: Windows > Microsoft.NET > Framework (for 32 bit operating system) or
C: Windows > Microsoft.NET > Framework64 (for 64 bit operating system)
There needs to be a subfolder named v3.5

NOTE: If the above requirements are not met in any way, the environment is not certified for use by SteamLogic™ and therefore functionality and performance cannot be guaranteed.
Installation

- Obtain License Key
  - Visit https://www.armstronginternational.com/steamlogic/register
  - Follow on-screen instructions to obtain License Key

- Insert the SteamLogic™ CD-ROM into the CD-ROM drive in the PC (or double click on the file downloaded which is explained in section Downloading SteamLogic™ from the Web on page 13.).

- Follow on-screen instructions to install SteamLogic™
  - If the installation instructions are not displayed, run the file on the CD-ROM named “Setup.exe” from an Explorer window.

NOTE: If the installation instructions indicate that .NET Framework 3.5 needs to be installed and “Would you like to do this now?”, click the Yes button if the computer has internet access. If the computer does not have internet access, click No and follow the instructions on page 15. Once .NET Framework 3.5 is installed, rerun Setup.exe (or run downloaded installer from procedure on page 13).
Installation

Install SteamLogic 1.2.1 for the first time

1. When installing SteamLogic for the first time the Welcome to the SteamLogic Setup Wizard dialog will appear. Click on the Next button in the lower right corner.

![Welcome to the SteamLogic Setup Wizard dialog]

WARNING: This computer program is protected by copyright law and international treaties. Unauthorized duplication or distribution of this program, or any portion of it, may result in severe civil or criminal penalties, and will be prosecuted to the maximum extent possible under the law.
2. The Select Installation Folder dialog box displays next. There will be a default folder path and the “Just Me” option selected. It is highly recommended that you leave the folder path as the default. The “Everyone” option makes the SteamLogic™ application available to anyone (any account) who logs onto the SteamLogic™ machine. The “Just Me” option only makes it available to the account that is logged on during the installation.
3. Click Next when ready and the Confirm Installation dialog will appear. You’ll still have the option to use the Back button to go back and change any setting on the previous dialog.
4. When ready, click Next again. The install will begin.
5. When finished you'll see the Installation Complete dialog. Click Close.
Installation

Upgrading to SteamLogic 1.2.1

In order to provide the best possible user experience, starting with version 1.2.1, the SteamLogic database is managed differently. The switchover may require quite a bit of processing during the upgrade if the database has grown to over a gigabyte under a previous version. Before upgrading to version 1.2.1, the database should be checked for size and if it's greater than 1 gigabyte, contact support to have the database manually upgraded before proceeding.

To check the database size:
1. Open Windows explorer by clicking Start -> Computer (or My Computer)
2. Navigate to C:\ProgramData\Armstrong International\SteamLogic. (for Windows XP navigate to: C:\Documents and Settings\All Users\Application Data\Armstrong International\SteamLogic)
3. Check the size column of the file SteamLogic.sdf. Make sure it is not more than 1,000,000 KB.

Example 1: 997,052 KB - This is Ok. Go ahead with upgrade.

Example 2: 1,091,176 KB - Call Support (SEE NEXT PAGE).

If the size of the file SteamLogic.sdf is greater than 1,000,000 KB, contact SteamLogic Support for further instructions.

To contact SteamLogic Support:
Email: helpdesk@armstronginternational.com
Or Call: 269-279-3400
Installation

■ Install SteamLogic 1.2.1 over an earlier version

When installing SteamLogic over an earlier version the install will appear almost identical to a first time install. The three additional things you will need to know are:

1. It is important to install with the same account used for the original install.

2. When the option to select “Just Me” or “Everyone” is displayed, it is important to select the same option that was selected when the earlier version was installed. If a different option is selected, the install will fail and any changes that were made are rolled back to the original version. You’ll know the incorrect option was selected by the message:

   Clicking on Okay will display the Installation Incomplete dialog:

If the wrong option is selected, rerun the installer and select the other option.
### Installation

3. During the installation processing, you will get a dialog that looks like the following:

![SteamLogic Files in Use](image)

The following applications are using files which the installer must update. You can either close the applications and click "Try Again", or click "Continue" so that the installer continues the installation, and replaces these files when your system restarts.

SteamLogic Polling Service (Process id: 8628)

If you see this, just click on Continue.
Downloading SteamLogic™

■ Downloading SteamLogic™ from the Web

If an earlier version of SteamLogic™ is already installed on the client computer, you can perform the following procedure to download the latest version:

1. Open your browser and go to: http://www.armstronginternational.com/steamlogic
2. Log into the site by clicking on Click here to log in (or click “LOG IN” in the upper right of the page). You will see your registered sites.
3. Click on the Download page link.
4. Click on the Download or Download Page link.
5. Click on the SteamLogic link after “Current Version”.
6. The install program will download to your computer when you choose to save it. Make a note of where the file SteamLogicSetup.msi is downloaded. It will usually be in your Downloads folder.

NOTE: Internet access is required to perform this task. If internet access is not available to the computer running the SteamLogic™ application, then this procedure must be performed on a separate computer with internet access. The SteamLogicSetup.msi file must be saved onto a portable storage device and transferred to the computer running SteamLogic™.
Verifying Computer Operating System Properties

Right click on the Computer (or My Computer) desktop icon and choose Properties from the menu options. If the displayed dialog box has tabs, click on the General tab. The information for the Windows Edition and whether it is 32 or 64 bit operating system will be shown.

**NOTE:** If there is no Computer (or My Computer) desktop icon, right click on an open area of the desktop and choose Personalize (or Properties) from the list of menu options.

If you had to choose Personalize do the following:
1. Click on Change desktop icons link on the upper left.
2. Check the Computer desktop icon checkbox.
3. Click Ok.
4. Close the Personalize dialog box.
5. The Computer icon should be visible on the desktop.

If you had to choose Properties after right clicking on the desktop, do the following:
1. On the Display Properties dialog, click the Desktop tab.
2. Click on the Customize Desktop… button.
3. Check the My Computer desktop icon.
4. Click Ok.
5. Close the Display Properties dialog box by clicking on Ok.
6. The My Computer icon should be visible on the desktop.
   If the My Computer icon still does not show:
   a. Right click on the desktop and choose Arrange Icons By > Show Desktop Icons.
Installing Microsoft .NET Framework

If installing Microsoft .NET Framework 3.5 SP1 on a computer that does not have internet access, do the following:

1. Go to a pc that does have internet access and go to download page:  
2. Click on the Download button.
3. Save the file to a known location on the hard drive (Default is usually the Download folder).
4. Copy the file (dotnetfx35.exe) to a thumb drive.
5. Take the thumb drive to the pc to install SteamLogic™ on and copy it to a known location on the hard drive and run it (double click it in Windows Explorer).
6. Follow any install instructions to complete the install.

If the computer does have internet access, do the following:

1. On the pc, go to download page:  
2. Click on the large Download button to the right near the top of the page.
3. Click next without selecting any additional downloads. The file will download to the hard drive.
4. Find the file location on the hard drive (Default is usually the Download folder).
5. Run the file (dotnetfx35setup.exe) and follow any install instructions to complete the install.

NOTE: Read the instructions on the download page before installing. If necessary, contact IT or your computer specialist to assist with the install. Additional patches may need to be installed afterwards or special minimum requirements that should be checked first. There are currently two patches as of this release, KB959209 and for Windows Vista 64-bit, KB967190.
Uninstalling SteamLogic™

There are two ways to uninstall SteamLogic™. See both methods below.

- Use the Window’s “Add/Remove Programs” or “Programs and Features” utility in Control panel, depending on the Operating system. The procedure is as follows:

  1. Right click on the **Computer** (or **My Computer**) icon on the desktop and choose **Manage** to open the Computer Management utility.
  2. Double click on **Services and Applications** and then select **Services**.
  3. Scroll down to the Service named SteamLogic™ Polling Service, right click on it and choose **Stop**.
  4. As a precaution, back up the SteamLogic™ database, SteamLogic.sdf by making a copy of it in a separate folder (under Documents or My Documents for instance). Depending on the operating system it will be in one of the following places:
     - For Windows XP:
       - C:\Documents and Settings\All Users\Application Data\Armstrong International\SteamLogic
     - For Windows 7 and Vista:
       - C:\ProgramData\Armstrong International\SteamLogic
  5. Go to **Start > Control Panel > Add/Remove Programs** (or Programs and Features in Windows 7).
  6. Right click on the **SteamLogic™ Application** and choose **Uninstall**. The uninstaller program will uninstall SteamLogic™.

**NOTE 1:** In step 4, if you cannot find the folder where the database is to back it up, follow the procedure below to show hidden folders.

For Windows XP and Windows 7:

  1. Open **Windows Explorer** by pressing the E key with the **Windows** key held down.
  2. From the **Tools** menu select **Folder options**....
  3. Select the **View** tab.
  4. Under **Hidden files and folders** select the **Show hidden files, folders and drives** radio button.
  5. Click on the **Apply** button and then **OK**.

For Windows Vista (32 and 64 bit):

  1. Open **Windows Explorer** by pressing the E key with the **Windows** key held down.
  2. From the **Organize** menu select **Folder and Search Options**.
  3. Select the **View** tab.
  4. Under **Hidden files and folders** select the **Show hidden files, folders and drives** radio button.
  5. Click on the **Apply** button and then **OK**.

Stay in **Explorer** and you should now be able to navigate to the folder where the SteamLogic™ database (SteamLogic.sdf) is located. It is recommended to turn Hidden folders back on after the database is backed up by repeating the procedure, but this time unchecking the Show hidden files, folders and drives radio button.

**NOTE 2:** The Database holds all the gateway and device configuration information along with the polling data and license key. If this information is lost, the process of reconfiguring the gateways and devices will have to be repeated after reinstalling or upgrading SteamLogic™ on this machine.
Uninstalling SteamLogic™

**NOTE 3:** If after reinstalling SteamLogic™ it is asking for a License Key when started up, or if the gateways and devices are not configured the same as before the reinstall, follow these instructions: shutdown SteamLogic™, stop the SteamLogic™ Polling Service, and restore the database from the location it was backed up to in steps 1 – 4 above. Then restart the SteamLogic Polling Service.

The recommended way to restore the database is to rename the newly installed database file and copy the backed up file to replace it in the …\Armstrong International\SteamLogic folder. Then restart the SteamLogic™ Polling Service and the SteamLogic™ application (same as step 3 above except click start instead of stop to start the service).

### Install SteamLogic 1.2.1 over the same version

If you try to run the installer over the same version as the installer, you will still get the Welcome to the SteamLogic Setup Wizard dialog, but the message will say ‘Select “Finish” to remove SteamLogic’ and the two options are a Cancel and a Finish button. The Finish button will simply uninstall SteamLogic.
Uninstalling SteamLogic™

If you click on Finish, the un-install begins.

If the SteamLogic Polling Service or SteamLogic Monitor is running, you will see a dialog that looks like this:

Whenever you see this, just click on the Continue button.
At this point SteamLogic will have been removed. The SteamLogic™ database, which contains all the configuration and device history, will still remain.
Initial Startup

- Start the software by clicking on the SteamLogic™ desktop icon.
- Enter License Key obtained from Armstrong’s registration website (see page 5).
SteamLogic™ Homepage

The SteamLogic™ homepage organizes all of the tools for SteamLogic™. Tabs are organized by Set Up, Monitoring and About. From the Set Up page, add gateways, discover and edit devices, create reporting groups and change preferences. Monitor and check the status of steam traps in operation by visiting the Monitoring page. The About page stores all software information such as the License Key, Software Version, and compatible devices. The Help tab displays this manual.

Set Up

Network Time Protocol Setup

It is highly recommended that the discovered gateways for the system be set up using the available Network Time Protocol (NTP). This will help maintain the prior time syncing within the device database. Log on to the gateway, select Setup -> Time from the left navigation panel. Select Network Time Protocol (NTP) as the Method used to set time. Enter the proper information under the Primary and/or Secondary Time Server sections. Select Submit.

Note: Before setting up a gateway in SteamLogic, the Hart IP port must be enabled in the gateway. Check the Enable checkbox for HART-IP on the gateway’s “Setup -> Security -> Protocols” page and click the submit button. The HART-IP TCP Port on this page is the port number to enter into SteamLogic for the gateway port.

By clicking Set Up and choosing Gateway, you can add a new gateway, connect the gateway, communicate with devices, and edit and delete gateways.
Adding a New Gateway

1. Click the Set Up tab.

2. Click add new.

3. Click Save.

Enter an IP address, HART IP Port, and Description into the fields and click Save.

Note: Hart IP must be enabled before adding a new Gateway. See page 21, SteamLogic™ Homepage -> Set Up.

At this point, the Gateway Set Up will show up in the screen.
Adding a New Gateway

- **Test Connection** is used when you would like to make sure that your Gateway is communicating correctly.

- **Discover** finds all of the devices that are connected to the gateway.

- **Edit** will let you change different settings in your Gateway:
  - IP Address
  - Port
  - Description
  - Monitor Tag
  - Out of Service

- **Deleting** Gateways will remove all associated traps (their presence, configuration, and historical data) from SteamLogic™.
Configuring Devices

Once a Gateway is added, the software will automatically find the devices connected to it. To configure more Gateways, click Return to Gateway List and refer to Adding a New Gateway section on page 22.

To configure the devices, click **Edit** in the Device List.
Configuring Devices

Once the Device List appears, the filter controls will appear at the bottom of the screen. Choose the type of device to view. Choose either Non-configured devices, configured devices or both. Or sort by choosing a preferred Gateway.
Configuring Devices

Click Edit to edit a device. The Device Edit screen will appear. Fill out the details of the device. Make sure to fill in all required fields (indicated by a *).

Once the first device is configured, the following fields will automatically populate from the last device configured: Trap Type, Pressure In, Pressure Out, Pressure Units, Update Frequency, Indoor/Outdoor and Out of Service fields. Click Save to complete the configuration.

For information about the Configure Advanced Settings button, see Appendices A, B and C.

Update frequencies are configured by the Burst Rate setting. They can be set in increments of one minute and the minimum should be 5 minutes for steam trap monitoring.

A check mark will appear in the Configured Box, signaling that the device was correctly configured and the date and time of the saved configuration will be shown in the “Last Config Change” column. Devices are now ready to be monitored.
Troubleshooting Tips

Knowledge of steam systems and how they are monitored is critical in utilizing SteamLogic™ as the valuable tool it can be. The better the understanding of steam systems and what SteamLogic™ is indicating, the more likely the root cause of an issue will be addressed. One thing to keep in mind in using SteamLogic™ is it calculates trap states based on acoustic and temperature readings it receives from the monitoring devices. Two major factors that can affect trap status determination; ambient noise and ambient temperature. A third factor can be neighboring system issues that get picked up by the monitoring devices. Let’s take a look at each one in turn:

1. SteamLogic™ determines blow thru traps based on the noise emitted from the blow thru condition. There is filtering used to help eliminate non-blow thru ambient noise surrounding the trap location, but excessive noise (including that from failed neighboring steam components) can cause a good trap to look like a blow thru in SteamLogic™. If it turns out that the normal ambient noise in the surrounding trap environment is causing an obviously good trap to read as blow thru in SteamLogic™, it may be time to consider using the Advanced Noise Filter Level setting for that trap. The default setting is “Normal”, but it can be increased to Medium or High. Caution should be used when adjusting this setting, as it is important not to mask real issues by setting it too high. It is important to use this setting only after a thorough investigation of the trap and surrounding equipment has verified the steam trap and surrounding system has no issues.

2. Cold traps are determined by comparing the ambient temperature (Electronics temperature) to the steam temperature as measured on the outside of the pipe (Stem Temperature). If the ambient temperature fluctuates over wide ranges it is possible for relatively cold pipes to toggle back and forth between Good and Cold as the differential threshold keeps getting crossed. If this is happening, it might be a good idea to up the advanced Temperature DeadBand setting to medium or even high.

3. There are times when a trap may be in a Good condition, but show as blow thru or cold in SteamLogic™ due to neighboring devices in the steam system. It’s possible for a blocked steam trap or closed valve downstream from a monitored trap to cause the monitored trap to look cold in SteamLogic™ because condensate has backed up to the pipe location of the monitored trap, cooling the pipe where the temperature is measured. Likewise, if steam is blowing out of a neighboring location in the pipe, it could make the trap look like it’s in a blow thru state because of the noise. It is important to keep in mind that if a trap has failed in SteamLogic™, it may be because of a steam system issue and not necessarily the trap itself. Investigate trap failures in the software with an open mind as to the root cause, although overwhelmingly often, failed traps will be due to the trap being monitored itself.

In summary:

- SteamLogic™ can alert you to steam issues not caused by the specific devices being monitored.
- It is important to utilize steam expertise in diagnosing root causes of issues revealed by SteamLogic™.
- It is also important to understand that Advanced Settings are designed to filter out non steam related environmental factors so that it can do its job in monitoring your steam system.
- SteamLogic™ Advanced Settings should not be used to filter out other steam related factors that may need to be addressed.
Reporting Groups

Any configured device can be organized in its own group to be specifically monitored.

1. By clicking Set Up, a list will appear. Click Reporting Groups. At the bottom of the screen, Click Add New.

2. Type in a desired name for the reporting group. Then select the devices to add to the reporting group. Select more than one device by holding Control (CTRL) on the keyboard, while selecting additional devices. Once the devices have been selected, click the Add Button located in the middle of the screen to carry over the selected devices. Click Save.

3. A reporting group has now been created. That particular group can now be monitored. It will show up as a tab on the Monitoring screen.
Preferences

Access Steamlogic™ Preferences by clicking **Set Up**, then **Preferences**. Temperature Units can be changed here.
Monitoring

Traps can be monitored after a Gateway has been added and the devices have been configured.

The monitoring tab is located at the top of the screen, next to Set Up. Click Monitoring, this will bring up a detailed list of monitored Devices and Gateways. The Trap Status of each device is displayed by an icon that represents the condition of the trap. The icons are defined in the legend beneath the monitoring page.

The Trap Status icons have the following meanings:

**Good Trap** - The steam trap is functioning normally under the current settings of the Trap Details Configuration.

**Cold Trap** - Reasons for the “Cold Trap” State:
- Steam trap is failed in a closed position. Steam trap may have a mechanical failure or plugged with solids.
- Steam supply is turned off.
  - Constant Steam Supply - Valve upstream of Steam trap is off
  - Modulating Steam Supply - Valve upstream of steam trap is off or modulating control valve is in the closed position.
- Steam trap is flooding or undersized for the application. May experience both Good and Cold conditions at the monitor point depending on current condensate load on trap.

**Blow Thru Trap** - Reasons for the “Blow Thru Trap” State:
- Steam Trap has failed in the open position. Steam trap may have a mechanical failure causing it to stick open.
- Steam trap may have a temporary failure due to improper installation.
- Steam trap may have acoustical interference due to surrounding equipment failure.
Monitoring

⚠️ Status Alert – Steam trap status is excessively flipping between states. Please investigate the operation of the steam trap and surrounding equipment. The trap may be undersized.

⚠️ No Data Available - Reasons for the “No Data Available” State.
  • Device has recently been configured and the state has not been determined yet.
  • Gateway has lost communication with the transmitter so the state cannot be confirmed.
  • Device has a fault/error causing the state to be undeterminable.

⚠️ Device Not Configured - The transmitter has been discovered, but has not been configured with the required settings. Edit the Trap Details to Configure the device.

🗗 Out of Service - Use the “Out Of Service” feature in device edit when a steam trap (or a group of steam traps) has a scheduled period of down time to eliminate presenting the trap as a Cold trap. Out Of Service overrides all other trap states.

Th sofware is programmed to provide two stages of alerts as power modules reach the end of their lives. The status meanings are as follows:

- Good
- Low – Power module should be replaced soon.
- Critical – Power module should be changed immediately.

In the legend, both the trap status and power module status quantities are shown, indicating the number of devices that are reporting each status. The numbers reflect the devices shown in the current filter and or reporting group tab, so they will generally change when the filter is changed from “All” devices to “Failed Trap”, for instance.

There is always an “All Devices” tab which allows the display of every transmitter on all gateways within the system. There is a filter dropdown that defaults to All which shows every transmitter and can be changed to only show trap that are of a certain status, or only those that have failed in some way (Cold or Blow Thru). There is also a Critical Devices only checkbox that filters out all devices that have not been configured as Critical in their Device Settings.

If one or more reporting groups are set up, they will show as additional tabs to the right of “All Devices”. When a reporting group tab is selected then only the transmitters that belong to that reporting group are displayed. The filters can then be used to select only devices indicating a certain status or only critical, just as for “All Devices”.

The other columns on the Monitoring page are the following:
  • Trap Tag # - This is a trap designator that is not stored in the monitoring device. It is assigned by the person who configures the device in SteamLogic™. Ideally, it should also be indicated on the physical trap itself in the field for identification purposes.
  • Stem Temp – The pipe temperature just upstream of the trap. If this temperature drops below a certain threshold, the trap status will be cold.
  • Trap Type – The type of trap that is being monitored by this device. It can be any one of the following: Bi Metal, Disc, Float, F & T, Inverted Bucket, Thermostatic or Orifice.
  • Critical – This checkbox is checked if the device is configured as a critical trap monitor. To make a trap critical, check the Critical checkbox in the device edit page. This is only to indicate a higher priority to this trap by the person who monitors the traps.
Monitoring

- **Trap Status Change Timestamp** – This is the time that the trap changed to its current status as shown in the Trap Status column.
- **Monitor Tag** – A device designator that is stored in the device and can be changed in SteamLogic™ using the Device Edit page.
- **Burst Rate** – This is the amount of time between device status updates in SteamLogic™. It should almost always be 5 minutes and never less. It is stored in the devices and configurable on the Device Edit page. Once the device is configured in SteamLogic™ it should only be changed using SteamLogic™.
- **Monitor Status** – This is either Good (green) or Bad (red) indicating if the gateway has detected any problems with the transmitter.
- **Gateway** – Shows with gateway the device is communicating with. It’s the gateway’s Monitor Tag that can be configured in the Gateway Edit page.

The trap list is sortable by Trap Tag Number, Monitor Tag or by using the Trap Status filter located directly beneath the monitoring page.

By double clicking on a device on the Monitoring page, a new set of 3 tabs appear that are specific to that device. The three tabs are the following:

1. **Device Details** – This tab shows all the device configuration information. It’s the same information that’s on the Edit Device page. To edit the information there is an Edit button in the lower right that navigates to the Device Edit page for that device. In a system with a large number of devices this makes an easy way to find a device’s Edit page from the Monitoring page. This tab is also the easiest way to get the location for a device from the monitoring page. Ideally, something should be put into the Location field for a device that makes it easy to determine where the trap is so it can be accurately found and serviced if it has any indication of failure.

2. **Trap Status History** – This tab shows the history of the states that the device has been in. It shows the current temperature, the time the device entered each state (First Occurrence), the last time it was in that state (Last Occurrence) and the number of polls it has been in that state (Count). Each time the trap status changes another row is added to the top as the most recent states come first; the current being on top.

3. **Polling Data History** – This tab shows the raw data from each time the device is polled by SteamLogic™. Every time a device is polled a new entry is added to the listing; the most recent polls are at the top.
Backing Up and Restoring the Database

The first time to back up the SteamLogic database is after it has been installed and the Gateways and devices have all been added and configured. Saving the database at this point ensures you can always get your configuration back if for any reason they get lost. See page 34.

To back up the database:

1. Configure all the gateways, devices and preferences that you want to save. Stop the SteamLogic Polling service and the SteamLogic Monitor.
2. Copy the C:\ProgramData\Armstrong International\SteamLogic\SteamLogic.sdf (or C:\Documents and Settings\All Users\Application Data\Armstrong International\SteamLogic\SteamLogic.sdf" for Windows XP) file to a safe and secure location, preferably to a DVD or network share on a machine at another location.
3. Restart the SteamLogic Polling Service and Monitor.
4. Schedule steps 2 through 4 above as frequently as necessary to prevent excessive loss of polling and state change data.

To recover from corruption:

1. Stop the SteamLogic Polling service and the SteamLogic Monitor.
2. Rename the corrupt database file:
   C:\ProgramData\Armstrong International\SteamLogic\SteamLogic.sdf.
3. Restore the SteamLogic.sdf file from the most recent backup.
4. Restart the SteamLogic Polling Service and Monitor.
Best Practices Regarding Software and Databases

Armstrong International strongly recommends that all SteamLogic™ customers back up their databases and take precautions to prevent power loss, physical shaking or over heating to the machine running SteamLogic™.

To minimize the possibility of database corruption:

1. Use a SteamLogic-dedicated machine in a controlled area with temperature control, a UPS (uninterruptable power supply) and up-to-date antivirus software.
2. Make sure all the Windows patches are installed and kept up-to-date.
3. Make sure all the SQL Server CE 3.5 service packs and patches are kept up-to-date.
4. Use regular RAM for memory.
5. Back up the database after the gateways and devices have been configured in SteamLogic.
   a. Configure all the devices.
   b. Stop the SteamLogic Polling service and the SteamLogic Monitor.
   c. Copy the C:\ProgramData\Armstrong International\SteamLogic\SteamLogic.sdf (or C:\Documents and Settings\All Users\Application Data\Armstrong International\SteamLogic\SteamLogic.sdf” for Windows XP) file.
   d. Restart the SteamLogic Polling Service and Monitor.
   e. Schedule steps b through d above as frequently as necessary to prevent excessive loss of polling and state change data.

To recover from corruption:

1. Stop the SteamLogic Polling service and close the SteamLogic Monitor.
2. Rename the corrupt database file:
   C:\ProgramData\Armstrong International\SteamLogic\SteamLogic.sdf.
3. Restore the SteamLogic.sdf file from the most recent backup.
4. Restart the SteamLogic Polling Service and Monitor.
Appendix A - Using the Noise Filter Level Advanced Setting

SteamLogic detects steam leaks and blow through traps by measuring noise levels of leaking steam. In noisy environments it may become necessary to filter out the surrounding noise so that sensitivity to leaking steam noise is restored. This can be accomplished by using the Noise Filter Level advanced setting. If a trap is being displayed as a blow thru in SteamLogic, the environment is noisy, and a Steam Expert has verified that there is no issue with the trap or surrounding steam system, gradually increase the Noise Level Setting for that device. It is important to not set this too high or real steam issues could be masked, and consequently, overlooked.

1. From the Monitor screen - Double Click on the Device to set.

2. Then click on Edit.
Appendix A - Using the Noise Filter Level Advanced Setting

3. Off to the right on the Set Up Devices screen there is a “Configure Advanced Settings” button. Click it.

4. The Advanced Setting screen will display. Across the top are the identifying device details to help ensure the correct device is being displayed. Along the left of the Advanced Settings pane are the actual settings that can be set: Noise Filter Level, Temperature DeadBanding and Device Status Alert. See Appendices B and C respectively for using the last two. To the right is Additional Information about using the Advanced Settings and the first three statements apply to the Noise Level Filter, indicating when to use it and warning of the danger.
Appendix A - Using the Noise Filter Level Advanced Setting

5. The Additional Information text is repeated here:

Activate Noise Level settings when the environment and/or operation of the monitored steam trap may be indicating excessive state changes between a Good Status and a Blow Thru Status.

Noise Level settings should only be used after a thorough investigation of the monitored steam trap and surrounding equipment.

Ignoring failed equipment can lead to equipment damage and potential employee safety issues.

6. There are three settings: Normal, Medium and High. Normal is the default and is set automatically when the device is first configured. If it is verified that there are no issues with the steam trap being monitored by this device or any surrounding steam system components and the trap is being displayed as blow thru in SteamLogic, then it might be a good time to consider changing the setting to Medium.

7. Make sure a steam expert has done the verification first. If the noise source causing the blow thru status is something unrelated to the steam system itself, then it should be okay to change to Medium. If the noise source is coming from some part of the steam system itself, this is not the change to use. The Noise Filter Level setting should not be used to mask issues in the steam system.

8. To change the setting, select the desired level and then click on the Save button.
Appendix A - Using the Noise Filter Level Advanced Setting

9. The Set Up Devices Edit screen will appear again, this time with a Box above the Configure Advanced Settings button that shows the Advanced Settings for the device. All three are shown and if they are set to the default, the text (DEF) is displayed to the right. The box only shows when one or more Advanced Settings are set to a non-default value. If the Advanced Settings are set back to all defaults, the box will disappear again.

10. Click the Save button to save the change and SteamLogic™ will navigate to the Set Up Devices List screen. Here, it can now be seen that the “Adv. Settings” checkbox for that device is now checked. This column will have a checked checkbox for any device that has any Advanced Setting not set to its default. The “Last Config Change” value will also change as this column always shows the day and time the last configuration was made to the device, including non-Advanced Settings changes.

11. From the Set Up Devices Edit screen you can navigate back to the Monitoring screen and wait and see if the new Noise Filter Level brings the trap back to a Good condition in SteamLogic™. It might take several polling cycles before it switches back. If the burst rate is 5, wait at least ½ an hour. If the trap still shows blow thru and the environmental noise cannot be reduced, try increasing the Noise Level Filter setting to High.
Appendix B – Using the Temperature DeadBanding Advanced Setting

SteamLogic™ detects cold traps by comparing the temperature of the steam pipe to the ambient. In certain instances this temperature differential can hover around the threshold difference between a good and a cold trap. If it frequently crosses back and forth over the threshold, the trap status will toggle just as frequently between good and cold (this is called flipping). Temperature DeadBanding will raise the threshold slightly when the trap is perceived as cold by SteamLogic and reduced slightly when perceived as good. This ensures stability of the trap status.

To Set the Advanced Setting – Temperature DeadBanding in SteamLogic™:

1. From the Monitor screen - Double Click on the Device to set.

2. Then click on Edit.
Appendix B – Using the Temperature DeadBanding Advanced Setting

3. Off to the right on the Set Up Devices screen there is a “Configure Advanced Settings” button. Click it.

4. The Advanced Setting screen will display. Across the top are the identifying device details to help ensure the correct device is being displayed. Along the left of the Advanced Settings pane are the actual settings that can be set: Noise Filter Level, Temperature DeadBanding and Device Status Alert. See Appendices A and C respectively for using the Noise Filter Level and Device Status Alert settings. To the right is Additional Information about using the Advanced Settings and the fourth statement applies to the Temperature DeadBanding setting.

Use Temperature Deadband settings to slow or contain state change “flipping”. Flipping may occur when a trap is operating under “swinging” temperature conditions, including heavy loads and rapidly modulating steam supply.
Appendix B – Using the Temperature DeadBanding Advanced Setting

5. The Additional Information text is repeated here:

Use Temperature Deadband settings to slow or contain state change “flipping”. Flipping may occur when a trap is operating under “swinging” temperature conditions, including heavy loads and rapidly modulating steam supply.

6. There are four settings: Low, Normal, Medium and High. Normal is the default and is set automatically when the device is first configured. If the device keeps frequently toggling between Cold and other Not Cold states (such as Good and Blow thru), then it might be a good time to consider increasing the setting to Medium or High. SteamLogic™ determines if a trap is Cold by comparing the Electronics (ambient) temperature to the Stem (pipe) temperature. If the Stem temperature does not exceed the Electronics temperature by a certain threshold the trap status will be displayed as cold.

7. If the difference between the two temperatures is very close to the threshold value and either or both of the temperatures drift, it’s possible for the device to toggle back and forth every polling cycle or every few cycles. The Temperature DeadBanding setting changes the threshold value by raising it a certain percentage of the threshold value when the trap status is Cold and lowering it that same percentage below the threshold when the status is Not Cold. The higher the percentage, the greater the drift would have to be to toggle the trap status.

8. To change the setting, select the desired level and then click on the Save button.
Appendix B – Using the Temperature DeadBanding Advanced Setting

9. The Set Up Devices Edit screen will appear again, this time with a Box above the Configure Advanced Settings button that shows the Advanced Settings for the device. All three are shown and if they are set to the default, the text (DEF) is displayed to the right. The box only shows when one or more Advanced Settings are set to a non-default value. If the Advanced Settings are set back to all defaults, the box will disappear again.

![Advanced Settings](image)

10. Click the Save button to save the change and SteamLogic™ will navigate to the Set Up Devices List screen. Here, it can now be seen that the “Adv. Settings” checkbox for that device is now checked. This column will have a checked checkbox for any device that has any Advanced Setting not set to its default. The “Last Config Change” value will also change as this column always shows the day and time the last configuration was made to the device, including non-Advanced Settings changes.

![Set Up Devices List](image)

11. From the Set Up Devices Edit screen you can navigate back to the Monitoring screen and wait and see if the new Temperature DeadBanding setting stabilizes the trap condition in SteamLogic™. It might take several polling cycles before it stabilizes on the true status. If the trap status is still flipping when set to medium, try increasing the Temperature DeadBanding setting to High.

![Monitoring Screen](image)
Appendix C – Using the Device Status Alert Advanced Setting

Issues in steam systems are sometimes revealed by rapid device status “flipping” rather than a constant display of a failed trap status. The Device Status Alert setting is designed to indicate these types of issues by displaying a status alert icon on the monitor screen if the status of a device changes too frequently. By default the setting will trigger a status alert for a trap if its status changes more than 3 times in an hour. This setting can be adjusted by increasing the number of status changes or the duration of which they must occur in. It can also be disabled if desired (disabled is a non-default setting).

To Set the Advanced Setting – Status Alert in SteamLogic™:

1. From the Monitor screen - Double Click on the Device to set.

2. Then click on Edit.
Appendix C – Using the Device Status Alert Advanced Setting

3. Off to the right on the Set Up Devices screen there is a “Configure Advanced Settings” button. Click it.

4. The Advanced Setting screen will display. Across the top are the identifying device details to help ensure the correct device is being displayed. Along the left of the Advanced Settings pane are the actual settings that can be set: Noise Filter Level, Temperature DeadBanding and Device Status Alert. See Appendices A and B respectively for using the Noise Filter Level and Temperature DeadBanding settings. To the right is Additional Information about using the Advanced Settings and the fifth statement applies to the Device Status Alert setting.
Appendix C – Using the Device Status Alert Advanced Setting

5. The Additional Information text is repeated here:

Use Status Alert settings to identify a potential issue in the steam system. Enabling this feature will cause the status icon to indicate a rapid flipping of states based on the configured settings.

6. There are two individual settings that work together: Trap Status Changes and Duration. The Device Status Alert setting is designed to show an alert when the trap has changed statuses more than a given number of times in a specific length of time. If the Status of a trap changes more than the given number of times in the specified duration, the status displays as Status Alert on the Monitor screen. The number of times is specified by the Trap Status Changes and the length of time by Duration (in minutes). The default for this setting is 3 status changes in 60 minutes, but the number and time can both be changed. Trap Status Changes can be set to anywhere from 3 to 10 and Duration can be set for 30, 60, 90 and 120 minutes. Neither limits the options of the other.

7. To change the setting, select the desired values and then click on the Save button.

8. The Set Up Devices Edit screen will appear again, this time with a box above the Configure Advanced Settings button that shows the Advanced Settings for the device. All three are shown and if they are set to the default, the text (DEF) is displayed to the right. If the Device Status Alert setting is disabled, then (DIS) is shown to the right of each of its two settings. (Disabling Device Status Alert put it in a non-default state) The box only shows when one or more Advanced Settings are set to a non-default value. If the Advanced Settings are set back to all defaults, the box will disappear again.

NOTE: The box only appears for configured devices or upon initial configuration if a device inherits non-default advanced settings from the last configured device.
Appendix C – Using the Device Status Alert Advanced Setting

9. Click the Save button to save the change. If you navigate to the Set Up Devices List screen, it can now be seen that the “Adv. Settings” checkbox for that device is now checked. This column will have a checked checkbox for any device that has any Advanced Setting not set to its default. The “Last Config Change” value will also change as this column always shows the day and time the last configuration was made to the device, including non-Advanced Settings changes.

10. From the Set Up Devices Edit screen you can navigate back to the Monitoring screen. When a device exceeds the number of status changes within the duration a Status Alert icon is displayed for that device as shown below. The device will keep this status until there are no status changes for this trap for the duration number of minutes. In the example case shown, the duration is set for 90 minutes so there must be a 90 minute period with no status changes for the Device Status Alert condition to turn off. A trap that is in Device Status Alert needs to be investigated to find out why its status is changing so often. Common causes are sources of noise or ambient temperature fluctuations. If after thorough investigation the trap is verified to be functioning properly and is the correct size for the location, the Device Status Alert setting may need to be changed.
Appendix D – Starting and Stopping the SteamLogic Polling Service

1. Open the Services manager by either holding down the windows key and pressing R or right clicking on the desktop computer icon and choosing manage from the drop down list.

2. If the former option is used, the Run dialog appears. Type services.msc in the field and click OK.

3. The following application appears. Scroll down to the service with the Name SteamLogic Polling Service. Right click and select Start(Stop) to start(stop) the service.
Appendix D – Starting and Stopping the SteamLogic Polling Service

4. For the latter option, the computer manager application will appear. Open the “Services and Applications” branch on the left and then select Services. As in Step 3 above, scroll down to the service with the Name SteamLogic Polling Service. Right click and select Start(Stop) to start(stop) the service.

NOTES:

• If the service is running (Started in the Status field) only the Stop option will be available. And if the service is stopped (blank in the Status field) only the Start option is available.
• Appearances may differ on different versions of Microsoft Windows.
Contact

Emerson:

Customer Central
1 800 999 9307 (7:00 a.m. to 7:00 p.m. CST)

National Response Center
1 800 654 7768 (24 hours a day)

Equipment Service Needs
International
1 952 906 8888